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Lab Objective 

In this lab you will learn how to use some of the features available in the System i 
Access for Web customization function. In particular, you will learn how to 
manage different homepage content for different users. The labs will customize 
home pages for a make-believe boat company called Access for Water.  

Before starting the lab exercises, make sure you have read the Lab Instructions 
document. Information contained in that document will be used in the lab tasks.  

Good luck with the lab exercises!  

Please raise your hand if you have questions!  
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Task 1: Changing the home page and template files 

System i Access for Web provides the following default home page and template 
files:  

/QIBM/ProdData/Access/Web2/html/homepage.html  

/QIBM/ProdData/Access/Web2/html/template.html  

NOTE: You should not modify the files in ProdData or create new files in this 
directory tree. The /QIBM/ProdData tree is intended for product files only.  

The homepage.html file is the page that is displayed when you access: 

http://<system>:<port>/webaccess/iWAHome 

The template.html file contains a header and footer to display on every page 
(except the home page).  The header is displayed before the System i Access for 
Web content and the footer is displayed after the content. A customized template 
file must include the tag %%CONTENT%%. When the page is displayed, this tag 
is replaced with the System i Access for Web content. 

There is also a main page, with tailorable content. The main page is displayed 
when you access: 

 http://<system>:<port>/webaccess/iWAMain 

Follow these steps to copy the new home page file, template file, and main page 
content to a new directory.  

1. Open a browser session. Open the System i Access for Web Home 
URL from the Lab worksheet section of the lab instructions package. Sign 
on to i5/OS using the User ID and Password from the lab instructions.  

2. You should see the default System i Access for Web home page. Click the 
Files navigation tab on the left side of your browser window.  

3. Click the Browse files link.  The IFS directory structure will be displayed 
on the page. 

4. The window contains a list of directories. Scroll down and click the walab 
directory link to display its contents.  

5. Click on the homepage directory that is displayed under the walab 
directory.  

6. The window is updated with the contents of the homepage directory. Scroll 
down until you find homepage.html. Click the Copy image (in the Action 
column) for file ‘homepage.html’.  
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7. Select the Browse button. Select the appropriate waxxdir by selecting the 
button next to the directory name. Click the Select button. Click the Copy 
File button. (Alternatively, if you prefer typing, you can enter 
/walab/homepage/waxxdir in the Destination field (where xx is your 
team number))  

8. Scroll down the window again until you find file ‘template.html’. Click the 
Copy image  (in the Action column) for file ‘template.html’.  

9. Select the Browse button. Select the appropriate waxxdir by selecting the 
button next to the directory name. Click the Select button. Click the Copy 
File button.  

10. Scroll down the window again until you find file ‘mainpage.html’. Click the 
Copy image (in the Action column) for file ‘mainpage.html’.  

11. Select the Browse button. Select the appropriate waxxdir by selecting the 
button next to the directory name. Click the Select button. Click the Copy 
File button.  

  

In this section, you will change the customization settings for WAxxGROUP to 
use the Access for Water template file. The group WAxxGROUP contains the 
users WAxx and WAxxADM.  

1. In the System i Access for Web browser window, click the Customize 
navigation tab on the left side of the window.  

2. Click the Policies link. 
3. Enter group profile name WAxxGROUP (where xx is your team number) 

in the Profile edit field and click the Edit policies button.  
4. Click the Edit Polices – General image (in the Action column) for the 

General category.  
5. In the Template HTML file policy Setting field, remove the current setting 

value and enter /walab/homepage/waxxdir/template.html (where xx is 
your team number) into the setting field.  

6. In the Navigation bar policy Setting field, select Hide from the dropdown 
list in the Setting column. 

7. Click the Save button at the end of the policy list.  
8. You should now see the new look provided by the template file.  

Follow the next steps to change the default home page to a new page that has 
been tailored for our boat company.  

1. Click the Edit Policies - General image (in the Action column) for the 
General category.  

2. In the Home page HTML file policy Setting field, remove the current 
setting value and enter /walab/homepage/waxxdir/homepage.html 
(where xx is your team number) into the setting field.  
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3. To allow us to navigate for the rest of this lab, we need to turn the 
Navigation bar back on temporarily. In the Navigation bar policy Setting 
field, select Show from the dropdown list in the Setting column. (In a real 
world environment where you replaced the default home page with your 
specific content, you would normally leave the Navigation bar setting set 
to Hide)  

4. Click the Save button at the end of the policy list. 
5. Click the My Home Page link in the upper left corner of the navigation bar.  
6. You should now see the Access for Water home page.  
7. We have put a Main link under the home page header banner to allow for 

navigation during the lab. You may not want to do this in a typical 
production environment where you are trying to restrict the functions a 
user sees.  

8. Click on the Main link. You should now see the System i Access for Web 
main page content. In addition to modifying the home page, some 
administrators may find it advantageous to keep the main page visible to 
their users. In this case, the administrator may want to replace the page 
content with something useful for their business. 

9. In the System i Access for Web browser window, click the Customize 
navigation tab on the left side of the window.  

10. Click the Policies link. 
11. Enter group profile name of WAxxGROUP (where xx is your team number) 

in the Profile edit field and click the Edit policies button.  
12. Click the Edit Policies - General image (in the Action column) for the 

General category.   
13. In the Main page HTML file policy Setting field, remove the current setting 

and enter /walab/homepage/waxxdir/mainpage.html (where xx is your 
team number) into the setting field.  

14. In the Navigation - Related links policy field setting, set it to Deny. This 
will hide the related links information found on the navigation bar.  

15. Click the Save button the end of the policy list. 
16. Click the My Home Page link in the upper left corner of the navigation bar. 

You should now see the Access for Water home page.  
17. Click the Main link. You should now see the new main page content. 

 

Task 2: Adding a Boats database request to the home 
page 

As you can see the boat home page isn't complete. Right now, WAxx and 
WAxxADM cannot do anything on the home page. In this task, and the following 
tasks, we will be adding useful links to the home page called Access for Water.  
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The first section we will complete is the Service section. In the Service section, 
there are two links that point to invalid resources. In this section you will update 
the home page file to include the correct URLs to allow the users access to 
certain functions. You will also add another group of links that will only be 
allowed by specified users, in this case a set of administrators.  

The first link you will update will allow the customer to see all the boats listed in 
the boat database table. Follow the steps below to create a System i Access for 
Web database request, and add the URL for that request to the Access for Water 
customized homepage.html file.   

1. From the main page, click the Database tab in the System i Access for 
Web navigation bar.  

2. Click the Run SQL link.  
3. In the SQL Statement text box, enter:  select * from boats.boats  
4. In the SQL Output --> Type dropdown dialog, select Hypertext Markup 

Language (.html).  
5. Click the Run SQL button. If the SQL request runs successfully, click the 

Back button in the browser session window to return to the Run SQL page.  
6. Click the Save Request button.  
7. In the Request name field, type waxx_request (where xx is your team 

number).  
8. In the Description field, type waxx All Boats.  
9. Select the Replace if already exists checkbox.  
10. Click the Save Request button.  
11. Click the My requests link.  
12. Click the Create Shortcut image (in the Action column) for the 

waxx_request request.  
13. In the Shortcut name field, replace the default name with waxx_public 

(where xx is your team number).  
14. Click the Add… button for the Access field, select All users from the list 

of Users, click the OK button. 
15. Click the Create Shortcut button.  
16. Click the My requests link in the navigation bar on the left. 
17. Click the Run image (in the Action column) for the waxx_public request.  
18. The request will run and the boat data will be displayed in the browser 

session.  
19. Now highlight (select) part of the URL request. Just highlight (select) 

everything after http://<system name>:<port>. Don't highlight (select) 
http://<system name>:<port>. Now select the Edit pulldown, and select 
the Copy option. Or just hit Ctrl+C keys with part of the URL request 
highlighted (selected). The highlighted portion of the URL should look 
similar to this (the request and access parameter order may be different):  

/webaccess/iWADbExec/sqlOutput.html?request=waxx_public&acc
ess=*PUBLIC  
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20. Click the browser Back button.  
21. Now we need to modify the home page to include a link to the request that 

was just created and run. Click the Windows Start button, select the Run... 
Option. In the Open field, type...  

wordpad c:\walab\homepage\homepage.html  

22. Search for text similar to...  

<!-- *************************** -->  
<!-- Add list of Services here   -->  
<!-- *************************** -->  

23. Directly underneath this text, there are a couple of html statements. In the 
first statement listed you will need to replace the ServiceLink1 text with 
the URL address that was copied above in step 19. Highlight (select) the 
ServiceLink1 text (not including the double quotes), select the Edit 
pulldown menu, and select the Paste option to paste in the URL address. 
Do not remove the double quotes. You should have a line that looks like 
the following (but it should all be on one line): 

<a href="/webaccess/iWADbExec/sqlOutput.html?request=waxx_p 
ublic&access=*PUBLIC">View available boats</a><br> 

Note: Parameter order may be different than what is shown above. This is 
OK.     

24. If you want to add the title Available Boats to the web page, add the 
parameter &caption=Available%20Boats to the end of the URL address. 
If you add the caption parameter then your html statement should look like 
the following (but it should all be on one line):  

<a href="/webaccess/iWADbExec/sqlOutput.html?request=waxx_p 
ublic&access=*PUBLIC&caption=Available%20Boats">View avail 
able boats</a><br> 

25. Click the File pulldown menu and select the Save option to save the 
changes. Close the Wordpad window.  

26. In the browser session, click the Files tab in the navigation bar. Click the 
Browse files link.  

27. In the Browse files window, click the walab directory link, click the 
homepage directory link, click the waxxdir directory (where xx is your 
team number) link. The window should be updated with the files that exist 
in the waxxdir directory.  

28. Select Copy Files to System from the drop-down list near the top of the 
page.  Click the Perform action button that is to the right of the drop-
down list.  The Copy Files to System page is displayed. 
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29. In the File field, type or browse for 
C:\WALAB\homepage\homepage.html, select the Replace file 
checkbox, click the Copy File button.  

30. In the upper left, at the top of the Access for Web navigation bar, select 
the My Home Page link.  

31. You should now have a View available boats link under the Services 
section. Click the link which will run the System i Access for Web 
database request that you saved earlier. The output will be displayed in 
the session window.  

32. The WAxxGROUP may not like how the data is displayed. You as an 
administrator could change the look by changing the saved database 
request to output in a different format.  

33. Click the Main link located on the home page.  
34. Click the Database tab.  
35. Click the My requests link.  
36. Click the Edit image (in the Action column) for the waxx_request request. 

Change the SQL Output --> Type field to Preview.  
37. Click the Save Request button.  
38. Select the Replace if already exists checkbox, click the Save Request 

button.  
39. In the upper left, at the top of the Access for Web navigation bar, select 

the My Home Page link.  
40. Select the View available boats link. The database output should be 

updated to display differently.  

 

Task 3: Adding a 5250 Boats application to the home 
page 

The second link you will update will start a 5250 application called boats. You will 
be using a parameter called initmac. This parameter identifies a macro to run 
after a session is started. Follow the steps below to create a macro called 
startboats, and add the link to the "Access for Water" home page.  

In order to create a macro you will need to sign on as the users that will be using 
the "Access for Water" home page. This is because a macro can only be 
accessed by the user that creates it and since we want to use a macro on this 
home page, we will need to have each user create it.  

We now need to create a macro for WAxx and WAxxADM. (where xx is your 
team number)  

1. Click the Main link located on the home page.  
2. Click the 5250 tab in the System i Access for Web navigation bar.  
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3. Click the Start Session link.  
4. Leave the field defaults as they are displayed. Click the Start Session 

button.  
5. Select the Start Recording button to begin recording the macro.  
6. Signon to the 5250 session as WAxx. (where xx is your team number) Hit 

enter until you get to a command screen.  
7. Type boats/boats on the command line and hit enter to run the boats 

application.  
8. Click the Stop Recording button.  
9. In the Macro field, enter startboats, click the Replace if already exists 

checkbox, and click the Save Macro button.  
10. Press the F3 key until you get to a screen with a command line. Type the 

command SIGNOFF and press the Enter key or select the Enter button in 
the keypad below the session window.  

11. Click the Active sessions link in the 5250 tab on the System i Access for 
navigation bar.  

12. Click the Stop image (in the Action column) to stop the currently active 
session.  

13. If you want the link to work correctly when using WAxxADM, repeat the 
steps 1-11 above, except use WAxxADM instead of WAxx. (where xx is 
your team number)  

14. Now we need to modify the home page to include a link to the 5250 
application that was just created and run. Click the Windows Start button, 
select the Run... Option. In the Open field, type...  

wordpad c:\walab\homepage\homepage.html  
15. Search for text similar to...  

<!-- *************************** -->  
<!-- Add list of Services here   --> 
<!-- *************************** -->  

16. Directly underneath this text, there are a couple of html statements. In the 
second statement listed you will need to replace the ServiceLink2 text 
with the following URL address that will start a session and run your 
macro. The URL address to start the session is: 

/webaccess/iWA5250?initmac=startboats 

After replacing the ServiceLink2 text with the URL address, the html 
statement should look like the following (but it should all be on one line): 

<a href="/webaccess/iWA5250?initmac=startboats">See boat 
details</a><br> 
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17. Click the File pulldown menu and select the Save option to save the 
changes. Close the Wordpad window.  

18. In the browser session, click the Files tab in the navigation bar. Click the 
Browse files link.  

19. In the Browse files window, click the walab directory link, click the 
homepage directory link, click the waxxdir directory link(where xx is your 
team number). The window should be updated with the files that exist in 
the waxxdir directory.  

20. Select Copy Files to System from the drop-down list near the top of the 
page.  Click the Perform action button that is to the right of the drop-
down list.  The Copy Files to System page is displayed. 

21. In the File field, type or browse for 
C:\WALAB\homepage\homepage.html, select the Replace file 
checkbox, click the Copy File button. 

22. In the upper left, at the top of the Access for Web navigation bar, select 
the My Home Page link.  

23. The See boat details link under the Services section should now run the 
5250 boats application.  

 

Task 4: Adding administrator specific tasks to the home 
page 

You can add a group of links in the Service section that can only be viewed by 
administrators. You won't need to create separate home pages for customers 
and administrators. You can do this by using the System i Access for Web 
include list support. The home page can contain an include list replacement flag. 
The format of the tag is %%include list=file%% where file identifies a file 
containing list items to include as links in a table. Follow the steps below to use 
this feature.  

1. There is a policy file already set up for you to use. To open it, click the 
Windows Start button, select the Run... Option. In the Open field, type...  

wordpad c:\walab\homepage\adminserv.policies  

2. Search for text that is similar to  

<profile name="WAxxADM">  

3. Replace xx with your team number. This will allow WAxxADM access to 
the links  

4. Click the File pulldown menu and select the Save option to save the 
changes. Close the Wordpad window.  
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5. In the browser session, click the Files tab in the navigation bar. Click the 
Browse files link.  

6. In the Browse files window, click the walab directory link, click the 
homepage directory link, click the waxxdir directory (where xx is your 
team number) link. The window should be updated with the files that exist 
in the waxxdir directory.  

7. Select Copy Files to System from the drop-down list near the top of the 
page.  Click the Perform action button that is to the right of the drop-
down list.  The Copy Files to System page is displayed. 

8. In the File field, type or browse for 
C:\WALAB\homepage\adminserv.policies, select the Replace file 
checkbox, click the Copy File button.   

9. Now you will need to include the policy file into the home page that will be 
displayed. Click the Windows Start button, select the Run... Option. In the 
Open field, type...  

wordpad c:\walab\homepage\homepage.html  
10. Search for text similar to...  

<!-- *************************** -->  
<!-- Add Adminserv.policies here --> 
<!-- *************************** -->  

Directly after this text, add the following statement: 

<td>%%include list=/walab/homepage/waxxdir/adminserv.poli 
cies%%</td>  

It should all be on one line, with a space between the include and list 
keywords.  Make sure to replace the xx in waxxdir with your team number.  

11. Click the File pulldown menu and select the Save option to save the 
changes. Close the Wordpad window.  

12. In the browser session, click the Files tab in the navigation bar. Click the 
Browse files link.  

13. In the Browse files window, click the walab directory link, click the 
homepage directory link, click the waxxdir directory (where xx is your 
team number) link. The window should be updated with the files that exist 
in the waxxdir directory.  

14. Select Copy Files to System from the drop-down list near the top of the 
page.  Click the Perform action button that is to the right of the drop-
down list.  The Copy Files to System page is displayed. 

15. In the File field, type C:\WALAB\homepage\homepage.html, select the 
Replace file checkbox, click the Copy File button.   

16. Open a new browser session signing on as WAxxADM.  
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17. You should now have additional links under the links that you added 
earlier. If you open a new browser session and sign on as WAxx you 
won't see the links. The list of items that you included can also be tailored 
to a group of users or all users (*PUBLIC). You can also add additional 
profile sections to adminserv.policies if, for instance, you want to have 
special links that only customers can use.  

NOTE: You need to use character references for characters that can be 
included in an XML document. For example, if you have a link with 
multiple parameters, you need to replaces & with &amp.  

18. Close the WAxxADM "Access for Water" browser windows.  

 

Task 5: Adding an image and movie to the home page 

Under the "This Week's Special" section, a picture of the boat special should be 
displayed along with a description. You will also show an Mpeg movie of the boat. 
To do this, you will need to update the home page to include this information. 
Open up the latest copy of the home page that you created.  

1. Click the Windows Start button, select the Run... Option. In the Open field, 
type...  

wordpad c:\walab\homepage\homepage.html  
2. Search for text similar to...  

<!-- **************************** -->  
<!-- Add This Week’s Special here --> 
<!-- **************************** -->  

3. After the following comment line,  

<!-- Add text to display carver.jpg here -->  

Add the following line of text.  

<img src="../images/carver.jpg" height=153 width=252>  

This is an html image tag. It will add the image of a boat to your home 
page.  
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4. After the following comment line,  

<!-- Add description and link to mpeg here -->  

Add the following line of text.   

<br><br>Beautifully maintained 28 foot 1978 Carver Santa 
Cruz for only $23,900. Click <a href="/webaccess/iWAFileD 
ownload/carver.mpg?filepath=/walab/homepage/images/carv 
er.mpg">here</a> to see this boat cruising the 
seas.<br><br><br>  

It should all be on one line with no spaces in the value specified on the 
‘href=’  tag. 

This will add the description and link to run the Mpeg movie of the boat.  

Note:  If you do not want to type this html text in directly, click the 
Windows Start button, select the Run… option.  In the Open field, type… 

wordpad c:\walab\homepage\customize.txt 
Find this HTML line of text in the ‘customize.txt’ file. Use the cut and paste 
functions of wordpad to copy this line of text from the customize.txt file 
and paste it into the homepage.html after the comment line described 
above. 

5. Click the File pulldown menu and select the Save option to save the 
changes. Close the Wordpad window.  

6. In the browser session, click the Files tab in the navigation bar. Click the 
Browse files link.  

7. In the Browse files window, click the walab directory link, click the 
homepage directory link, select the waxxdir directory (where xx is your 
team number) link. The window should be updated with the files that exist 
in the waxxdir directory.  

8. Select Copy Files to System from the drop-down list near the top of the 
page.  Click the Perform action button that is to the right of the drop-
down list.  The Copy Files to System page is displayed. 

9. In the File field, type C:\WALAB\homepage\homepage.html, select the 
Replace file checkbox, click the Copy File button.   

10. Open a new browser session signing on as user WAxxADM or WAxx.  
11. You should see an image of a boat and a link to run the mpeg movie.  
12. Close the new "Access for Water" browser window.  
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Task 6: Adding a Contact Us function to the home page 

Now we will add a section of the home page that provides customers with a way 
to send their comments and questions to the boat company.  

1. Click the Messages tab in the System i Access for Web navigation bar.  
2. Click the Send Message link.  
3. Now highlight (select) part of the URL request. Just highlight (select) 

everything after http://<system name>:<port>. Don't highlight (select) 
http://<system>:<port>. Now select the Edit pulldown, and select the 
Copy option. Or just hit Ctrl+C keys with part of the URL request 
highlighted (selected). The part that you highlight should look like this…  

/webaccess/iWASendMessage  

4. Now we need to modify the home page to include a link to the request that 
was just created and run. Click the Windows Start button, select the Run... 
Option. In the Open field, type...  

wordpad c:\walab\homepage\homepage.html  
5. Search for text similar to:  

<!-- ************************ -->  
<!-- Add Site Support here    --> 
<!-- ************************ -->  

6. Underneath this text, there is an html statement. In the first statement 
listed you will need to replace SiteSupport with the URL address that was 
copied above in step 3. Highlight (select) the SiteSupport, select the Edit 
pulldown menu, and select the Paste option to paste in the URL address. 
Do not remove the double quotes. You should have a line that looks like 
this…  

<a href="/webaccess/iWASendMessage">Send us a message</a> 

7. Click the File pulldown menu and select the Save option to save the 
changes. Close the Wordpad window.  

8. In the browser session, click the Files tab in the navigation bar. Click the 
Browse files link.  

9. In the Browse files window, click the walab directory link, click the 
homepage directory link, click the waxxdir directory (where xx is your 
team number) link. The window should be updated with the files that exist 
in the waxxdir directory.  
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10. Select Copy Files to System from the drop-down list near the top of the 
page.  Click the Perform action button that is to the right of the drop-
down list.  The Copy Files to System page is displayed. 

11. In the File field, type C:\WALAB\homepage\homepage.html, select the 
Replace file checkbox, click the Copy File button.   

12. In the browser session that is running "Access for Water", refresh the 
session or close it and open a new browser session signing on as either 
WAxx or WAxxADM.  

13. You should now see the new link under the Site Support section. Click the 
link which will run the System i Access for Web send message support. 
The Send Message screen should be displayed in the session window.  

14. Close the browser window.  

 

Task 7: Adding an external weather site to the home 
page  

Note: Skip this lab if you do not have access to the Internet. To determine if 
you have external access, try going to www.ibm.com in the browser session.  
This task does not include adding access to any System i Access for Web 
support, but shows you are not restricted to System i Access for Web functions 
on your home page. Follow the steps below to add this section. We are going to 
add a link to access the www.weathercenter.com if you click anywhere on the 
image.  

1. Click the Windows Start button, select the Run... Option. In the Open field, 
type...  

wordpad c:\walab\homepage\homepage.html  
2. Search for text similar to...  

<!-- ******************************** -->  
<!-- Add Weather Conditions link here --> 
<!-- ******************************** -->  

3. Underneath this text, add the following statement.  

<a href="http://www.theweathercenter.com"> 
<img src="../images/weather.gif" border="0" 
width="316" height="228"></a> 

It should all be on one line.  
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4. Click the File pulldown menu and select the Save option to save the 
changes. Close the Wordpad window.  

5. In the browser session, click the Files tab in the navigation bar. Click the 
Browse files link.  

6. In the Browse files window, click the walab directory link, click the 
homepage directory link, select the waxxdir directory (where xx is your 
team number) link. The window should be updated with the files that exist 
in the waxxdir directory.  

7. Select Copy Files to System from the drop-down list near the top of the 
page.  Click the Perform action button that is to the right of the drop-
down list.  The Copy Files to System page is displayed. 

8. In the File field, type C:\WALAB\homepage\homepage.html, select the 
Replace file checkbox, click the Copy File button.   

9. Open a new browser session signing on as either WAxx or WAxxADM.  
10. You should now see the image under the Weather Conditions section that 

you can click to view www.theweathercenter.com. Click on the image to 
check out the weather.  

11. Close the browser.  

 

Task 8: Adding additional replacement tags to the home 
page 

System i Access for Web supports some additional replacement tags in the home 
page files. Please feel free to try them out now that you know how to update the 
home page. Here are the replacement tags:  

%%TITLE%% Replaced with the page title. 
%%USER%% Replaced with the authenticated user name. 
%%SYSTEM%%   Replaced with the name of the i5/OS system being 

accessed. 
%%VERSION%% Replaced with the version of System i Access for Web 

currently installed. 

  

Task 9: Resetting Preference and Policy settings 
to their default values 

This task shows you how to reset policy settings to their default values. The 
following steps will reset the preference and policy settings you updated the 
tasks above. You should reset these settings before continuing on with other lab 
exercises.  
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1. Click the Customize navigation tab on the left side of your browser 
window.  

2. Click the Policies link. 
3. Click the Group profiles link. 
4. Locate your WAxxGROUP  (where xx is your team number) profile. 
5. Click the Reset policies image (in the Action column) for your group 

profile. 
6. Click the Reset Policies button on the Confirm Reset Policies page. 
7. From the tasks above, verify the settings have been restored to their 

default values. You may have to hit the Refresh or Reload buttons on your 
browser to make sure the browser isn't displaying a cached page.  

 
Congratulations!  

You have completed this System i 
Access for Web lab!  
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communicate IBM's current investment and development activities as a good faith effort 
to help with our customers' future planning.  
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